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Chapter 1 Copyright

Copyright

Published by Oscar Communications Pty. Ltd.
4 The Lee
Middle Cove, NSW, 2068, AUSTRALIA

All Rights Reserved

No part of this publication may be produced, stored in a retrieval system, or transmitted, in any
form or by any means, electronic, mechanical, photocopying, recording or otherwise, without the
prior written permission of Oscar Communications Pty. Ltd.

Unpack

Unpack the equipment and examine it thoroughly to ascertain whether any damage has occurred in
transit. Report immediately any such damage to the distributor, agent or manufacturer. Retain the
packing, should a return to manufacturer be necessary.

All Goods

All goods manufactured by the Company are guaranteed to the extent hereafter mentioned against
defects arising from faulty material or workmanship subject to the goods not having suffered
maltreatment or interference. The Company’s liability under this guarantee is limited to replacing
any part or parts found defective within a period as laid down in Company instructions after the
date of delivery or installation.

Other Goods

If goods not of the Company’s manufacture are ordered, the guarantee of that company is applicable
to those goods.

Descriptive Matter

Descriptive matter, illustrations, dimensions and weights issued by the Company are typical and
shall not be held as binding.

Patterns and Designs

The Company reserves the right to alter patterns and design without notice.

First published August 1994

We have taken every care in the preparation of this manual. If there are any inaccuracies,
ambiguities or omissions, Oscar Communications Pty. Ltd. and its consultants and distributors
cannot accept responsibility for any loss or damage these errors may cause.
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Warnings

Safety Measures

This instruction manual contains certain WARNING and CAUTION notices which must be
followed by the user to ensure safe operation and to retain the equipment in a SAFE condition.

All users of the equipment described in this manual MUST have received adequate training in its
use and application in order to ensure SAFE AND PROPER USE.

Any adjustment, maintenance or repair of the opened apparatus under voltage shall be carried out
only by a skilled person who is AWARE OF THE HAZARD INVOLVED.

Replacement of Parts

The replacement of parts must be with identical parts. In particular, fuses should only be replaced
by items of the same type and rating.

To the best of our knowledge the recorder does not contain any materials which are toxic or
otherwise injurious to health in the course of normal operation or maintenance.

In addition to the above you must ensure that you comply with all local Health and Safety
Regulations and meet any legal obligations arising from the use of this recorder.

Siting

Note that the Oscom 400 Digital Communications Recorder is not waterproof. Splashes on the front
of the recorder are likely to enter the tape drives and damage them. The recorder should not be sited
where it is likely to be splashed.

Do not place the recorder in an excessively dusty or dirty environment. The tape drive contains high
precision mechanical components which may become damaged or worn in such an environment.

The recorder has internal cooling fans. Air inlets and outlets must not be obstructed. The recorder
must not be operated in ambient temperatures in excess of 45oC.

The recorder has not been tested for RFI and hence is not claimed to meet FCC limits. However the
metal box construction of the recorder and the enclosure of the recorder in a metal rack (when
mounted) is expected to contain any internally generated RFI and protect the recorder against
external RFI.

Ensure the recorder is always operated within the limits of the technical specifications given in
Appendix A of this manual.
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Chapter 2 Installation

Unpacking

The Oscom 400 Digital Communications Recorder is normally supplied assembled and ready for
use (except for external connections and connection of the monitor, keyboard and mouse). Once
unpacked, keep the original packing materials for further transit. If the recorder is to be returned to
the manufacturer because it was damaged in transit, it must be returned in the original packing.

Desk Top or Rack Mounting (Oscom 400)

Physical installation should be such that the recorder is secure and safe. It is the responsibility of the
user to ensure that it does not pose a hazard by virtue of its physical location or means of
attachment. The recorder is designed to be mounted in either a 19 inch rack or on a desk top. If
mounted in a rack it should be supported by a rack tray.

Care must be taken to ensure that the system is not subject to the ingress of moisture or dust. This
will reduce the life of the system and in particular the tape drives.

Making the Connections

Mains Power Connection

The power connector is a 3 pin IEC plug. The recorder can accept one of two supplies.

110V      (+/-10)      60Hz      AC or 230V      (+/-10)      50Hz      AC

The rear panel contains a voltage selector switch labelled 110/230. It is important that the switch is
in the correct position for the supply.

Voice Channel Connections

The voice channel connectors are located on the rear panel of the line cards. Connections are made
via the RJ12 connectors. Each voice card allows for four voice channels. The connector pinout is as
shown in Table 2.2.

For each channel on a card, inputs A and B are connected to an isolating transformer with a
blocking capacitor. The polarity of the signal being recorded is not important, even if it is a
telephone line.

PIN FUNCTION
1 NC
2 NC
3 A Input
4 B Input
5 NC
6 NC

Table 2.1 Voice Channel Pin Allocations
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Installation

Fig.1 – Line Card Channel connections

Special Note:

“Telecommunications network voltage exist inside the voice logger. The line connection must
be disconnected before removing the cover (lid) and reconnected only after the cover (lid) is
replaced.”

Channel 4

Channel 1

Channel 2

Channel 3
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Chapter 3 Overview

Oscom400 is a program to convert your computer or network of computers into multi-channel
telephone/wireless communication recorder(s) by the simple addition of voice interface cards.

Oscom400 is the recording application. It operates in background mode under Windows 95, 98,
NT4 or Win 2000 and does not affect the normal operation of your computer. You can continue to
use you normal word-processor/spreadsheet etc. Call Manager will not affect them. On a typical
computer, with (say) a 10 Gbyte hard disc, Call Manager will keep a record of (typically) the last
month’s calls. A permanent archive of your calls can be made by adding a tape backup system such
as Novastor Backup. This is normally supplied with the Oscom400 and can be configured to
backup all new calls on a daily basis.

The following explain the various menus of the Oscom 400. More detailed explanations on the use
of each function is contained in the following chapter.

File menu commands

Tag Call Displays a dialog box for marking a call with a tag colour. This sets a tag
mark to appear next to the call in the list.  The call is not affected in any other
way. You can tag any call in any window. You can also add comments of up
to 100 characters. A call will remain tagged and commented even on tape,
and its tag mark and comment will always appear. Use this facility to make
searching for calls easier.

Play Call Opens a Replay Window for replaying the selected call.

Save Call Saves a call by copying it to a subdirectory called “Saved”. You can view the
Saved calls by means of the View Menu. Saved calls are not automatically
deleted by Call Manager; you must delete them manually when you no longer
require them.

Delete Call Deletes a saved call from the Saved directory. You can only use this
command to delete calls that have previously been saved

Convert Call Converts a call from the Oscar format (.CPX) into the Windows waveform
format .(WAV). The call can now be replayed by any multimedia computer.
By default, the converted files are played in the WAVE subdirectory.

Properties Displays the call file details, such as the version of Oscom400 used to record
it and the type of compression used.

Convert List Converts the active call list into either a .CSV file that can be read directly
into a spreadsheet or a formatted .TXT file that can be read directly into a
word processor.

Print Use this command to print a Call List. This command presents a Print dialog
box, where you may specify the print parameters.
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Print Preview Use this command to display the active Call List as it will appear when
printed. When you choose this command, the main window will be replaced
with a print preview window in which one or two pages will be displayed in
their printed format. The print preview toolbar offers you options to view
either one or two pages at a time; move back and forth through the document;
zoom in and out of pages; and initiate a print job.

Print Setup Use this command to select a printer and a printer connection. This command
presents a Print Setup dialog box, where you specify the printer and its
connection.

Exit Use this command to end your Oscom400 session. You can also use the
Close command on the application Control menu. Call Manager will
terminate any recording currently in progress.

View menu commands

New Local Call List Use this command to open a new call list window of calls on the local
computer. The Filter Calls Dialog is displayed, allowing you to
display only the calls in which you are interested.

New Network Call List Use this command to open a new call list window of calls on another
computer on the network. The Select Directory dialog is displayed,
allowing you to select the computer. Then the Filter Calls Dialog is
displayed, allowing you to display only the calls in which you are
interested.

New Saved Call List Use this command to open a new call list window of Saved calls on
the local computer. The Filter Calls Dialog is displayed, allowing you
to display only the calls in which you are interested.

Toolbar Use this command to display and hide the Toolbar, which includes
buttons for some of the most common commands in Oscom400, such
as File Open. A check mark appears next to the menu item when the
Toolbar is displayed. See Toolbar further on for help on using the
toolbar.

Status Bar Use this command to display and hide the Status Bar, which describes
the action to be executed by the selected menu item or depressed
toolbar button, and keyboard latch state. A check mark appears next
to the menu item when the Status Bar is displayed. See Status Bar for
help on using the status bar.
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Setup menu commands

Local Call Manager Configures the Call Manager on the local computer.

Supervisor Password Change the Supervisor access password.

Window menu commands

Cascade Use this command to arrange multiple opened windows in an
overlapped fashion.

Tile Horizontally Use this command to vertically arrange multiple opened windows one
above the other.

Tile Vertically Use this command to arrange multiple opened windows one beside
the other.

Arrange Icons Use this command to arrange the icons for minimised windows at the
bottom of the main window. If there is an open call list window at the
bottom of the main window, then some or all of the icons may not be
visible because they will be underneath this call list window.

1, 2… Oscom400 displays a list of currently open document windows at the
bottom of the Window menu. A check mark appears in front of the
document name of the active window. Choose a document from this
list to make its window active.

Help menu commands

Help Topics Use this command to display the opening screen of Help. From the
opening screen, you can jump to step-by-step instructions for using
Oscom400 and various types of reference information. Once you
open Help, you can click the Contents button whenever you want to
return to the opening screen.

About Use this command to display the copyright notice and version number
of your copy of the Oscom400 application.

Using Help command (Help menu)

Use this command for instructions about using Help.
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Context Help command

Use the Context Help command to obtain help on some portion of Oscom400. When you choose
the Toolbar's Context Help button, the mouse pointer will change to an arrow and question mark.
Then click somewhere in the Oscom400 window, such as another Toolbar button. The Help topic
will be shown for the item you clicked.

Shortcut
Keys: SHIFT+F1

Toolbar

The toolbar is displayed across the top of the application window, below the menu bar. The toolbar
provides quick mouse access to many tools used in Oscom400,

To hide or display the Toolbar, choose Toolbar from the View menu (ALT, V, T).

Add or remove toolbar buttons from the list below according to which ones your application offers.

Click To

View/New Local Call List

View/New Network Call List

File/Tag Call

File/Play Call

File/Print

Status Bar

The status bar is displayed at the bottom of the Oscom400 window. To display or hide the status
bar, use the Status Bar command in the View menu.

The left area of the status bar describes actions of menu items as you use the arrow keys to navigate
through menus. This area similarly shows messages that describe the actions of toolbar buttons as
you depress them, before releasing them. If after viewing the description of the toolbar button
command you wish not to execute the command, then release the mouse button while the pointer is
off the toolbar button.

The right area of the status bar contains a progress indicator. This shows the progress of any Save
Call or Convert Call operations.

The extreme right areas of the status bar indicate which of the following keys are latched down:
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Indicator Description

CAP The Caps Lock key is latched down.

NUM The Num Lock key is latched down.

Title Bar

Show your application's title bar here.

The title bar is located along the top of a window. It contains the name of the application and
document.

To move the window, drag the title bar. Note: You can also move dialog boxes by dragging their
title bars.

A title bar may contain the following elements:
Application Control-menu button
Document Control-menu button
Maximise button
Minimise button
Name of the application
Name of the document
Restore button

Scroll bars

Displayed at the right and bottom edges of the document window. The scroll boxes inside the scroll
bars indicate your vertical and horizontal location in the document. You can use the mouse to scroll
to other parts of the document.

Describe the actions of the various parts of the scrollbar, according to how they behave in your
application.

Size command (System menu)

Use this command to display a four-headed arrow so you can size the active window with the arrow
keys.
After the pointer changes to the four-headed arrow:
1. Press one of the DIRECTION keys (left, right, up, or down arrow key) to move the pointer to

the border you want to move.
2. Press a DIRECTION key to move the border.

3. Press ENTER when the window is the size you want.
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Note: This command is unavailable if you maximise the window.

Overview

Shortcut
Mouse: Drag the size bars at the corners or edges of the window.

Move command (Control menu)

Use this command to display a four-headed arrow so you can move the active window or dialog box
with the arrow keys.

Note: This command is unavailable if you maximise the window.

Shortcut
Keys: CTRL+F7

Minimise command (application Control menu)

Use this command to reduce the Oscom400 window to an icon.

Shortcut
Mouse: Click the minimise icon on the title bar.
Keys: ALT+F9

Maximise command (System menu)

Use this command to enlarge the active window to fill the available space.

Shortcut
Mouse: Click the maximise icon on the title bar; or double-click the title bar.
Keys: CTRL+F10 enlarges a document window.

Next Window command (document Control menu)

Use this command to switch to the next open document window. Oscom400 determines which
window is next according to the order in which you opened the windows.

Shortcut
Keys: CTRL+F6
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Previous Window command (document Control menu)

Use this command to switch to the previous open document window. Oscom400 determines which
window is previous according to the order in which you opened the windows.

Shortcut
Keys: SHIFT+CTRL+F6

Close command (Control menus)

Use this command to close the active window or dialog box.

Double-clicking a Control-menu box is the same as choosing the Close command.

Note: If you have multiple windows open for a single document, the Close command on the
document Control menu closes only one window at a time. You can close all windows at once with
the Close command on the File menu.

Shortcuts
Keys: CTRL+F4 closes a document window

ALT+F4 closes the window or dialog box

Restore command (Control menu)

Use this command to return the active window to its size and position before you chose the
Maximise or Minimise command.

Switch to command (application Control menu)

Use this command to display a list of all open applications. Use this "Task List" to switch to or
close an application on the list.

Shortcut
Keys: CTRL+ESC

Dialog Box Options
When you choose the Switch To command, you will be presented with a dialog box with the
following options:

Task List
Select the application you want to switch to or close.

Switch To
Makes the selected application active.

End Task
Closes the selected application.
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Cancel
Closes the Task List box.

Cascade
Arranges open applications so they overlap and you can see each title bar. This option does not
affect applications reduced to icons.

Tile
Arranges open applications into windows that do not overlap. This option does not affect
applications reduced to icons.

Arrange Icons
Arranges the icons of all minimised applications across the bottom of the screen.

The Call List Window

The Call Lists show all the calls in a particular directory on the Oscom400. Each Oscom400 has
two standard directories, CALLS (where the Local Call Manager places newly recorded calls) and
SAVED (where any saved calls are placed). Other directories may be added as you require.
Oscom400 can also display Call Lists for other computers on the network if you have Supervisor
access.

Using the Call List, you can Replay, or Tag a call to help identify it, Save a call to the SAVED
directory, or Delete a Saved Call. You can also Convert a call from the Oscar .CPX to the
Windows .WAV format. You can also convert the entire call list into a file suitable for inclusion in
a spreadsheet or word processor.

With all these functions you can select multiple calls to operate on simultaneously,

To Load a call ready for replay, either: select the File/Play Call menu, press the Play Call Toolbar
button, or double-click on the call itself.

To Tag a call, either: select the File/Tag Call menu or press the Tag Call Toolbar button.

To Save a call, either: select the File/Save Call menu. You cannot save a call that is already in the
SAVED directory.

To Delete a call, either: select the File/Delete Call menu. You can only delete a call that is in the
SAVED directory.

Each Call List has the same layout. The column widths are adjustable to view or hide different
fields.
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Call Number This is a unique number (for each Call Manager) that is used to create the call
filename. It can be used to identify a particular call.

Channel Number This is the channel (on each Call Manager) on which the call was recorded.

Date The date on which the call was recorded.

Time The time when the call started.

Duration The length of the call.

Dialled Digits The number that was dialled during the call.  This field is only shown for
outgoing calls. At this time, incoming calls cannot show the dialling number
(CLI).

Comment A note that you can add to help identify the call. The comment can be up to
100 characters. To add a comment, use the Tag. Menu command

The Replay Window

This window is shown when you double-click on a call, or select the File/Play Call menu or the
Play Call toolbar button. The window shows the start and end times of the call. The grey slider bar
represents the call itself. Click on the Play button bar to start replay. Click on the Stop button to
stop replay. The bar contains a progress indicator to show you how far through the call you are, and
the actual time being replayed is displayed on the button bar.

Replay can continue even while other applications are running. You can, for example, use
Oscom400 to replay a call and a word processor to transcribe it simultaneously.

You can open as many replay windows as you wish, the window which is selected as the active
window will be the one which performs the replay.

Call Manager Window

Call Manager is a separate application running Oscom400. Call Manager normally runs as a
minimised icon but may be expanded to a window showing the progress of each call.

Any Oscom400 on the network can access calls recorded on all computers on the network, provided
the Supervisor Password is given and presuming the network configuration allows it. Call Manager
can be configured using the Setup/Call Manager menu

The Call Manager window shows information about the recorded calls. These are stores in the Calls
subdirectory.



Oscar Communications Pty. Ltd
Oscom 400 Users Guide. Rev. 20 April 2001 Page. 16

Overview
Next Call This is the number that will be assigned to the next call that is recorded.

Total Call Data This is the total size of all the call files in the Calls subdirectory. The
maximum disc space set aside for call files can be set in the Call Manager configuration.

Recording Timer This shows if recording is enabled or disabled by the record Timers
In addition, the Call Manager window shows a line for each of the channels. If a call is in progress
it’s status is displayed in blue.  If the line is idle it is shown blank.

Call Manager cannot record your calls for ever without filling up your disc. Eventually it must start
deleting the oldest call as it records new ones.  Once per minute, Call Manager checks to see if the
total size of all call files exceed the value you entered in the Setup/Call Manager dialog box. If so,
the oldest call is deleted.

Call Manager cannot record an “infinitely“ long call; the file would never be competed. Because of
this, Call Manager checks once per minute to see if any call currently in progress is longer that the
value you entered in the Setup/Call Manager dialog box. If so, the call is ended and a new call
immediately started.  No data is lost during this operation.

Call Manager also allows us to listen to calls in real time. Real Time Monitoring can be carried out
by pressing on the button next to the channel the user wishes to listen to. Please note there is about a
one (1) second delay between the actual speech and the output from the speaker.

Tag Call Dialog Box

This dialog allows you to mark a call with a tag colour which will appear next to the call in the Call
List Window. You may also add a comment of up to 100 characters. The call is not affected in any
other way. You can assign a tag colour and comment to any call in any window. A call will remain
tagged and commented even on tape, and its tag mark and comment will always appear.

The comment may contain carriage returns and line feeds. These will be displayed as entered in the
Comment box but will appear as a single line in the Call List window.

Tag Colour Select the tag colour to assign to the call.

Comment Add a comment (100 chars max).

Filter Calls Dialog Box

This dialog box is displayed in response to a View menu command. You are about to view a list of
calls contained in a directory. The list may be very large and you might prefer to filter it to only
show calls in which you are interested. This dialog allows to select particular call parameters and
display only those calls that match.
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Date If the Show Calls with any date button is selected, no date filtering
will be performed.  If the Show only Calls Made On button is
selected, only calls with dates matching the filter will be displayed.
You must enter the date in the format dd mon yy.  E.g.   11 May 97.
The Today and Yesterday buttons are shortcuts to the current and
previous dates respectively.

Show Calls on Channel Check a box for each channel you wish to show. Unless you have
supervisor access rights you will only be able to display those
channels whose password matches the one given when Oscom400
was opened. Remember to have at least one box checked or no calls at
all will be displayed!

Dialled / Dialling numbers If the Show Calls with Any Number button is selected, no filtering
on dialled or dialling number will be performed. If the Show only
Calls made to/from button is selected, only those calls whose dialled
or dialling number matches the filter will be displayed. At the current
time Oscom400 does not support dialling number filtering, only
dialled.

Show Calls with Tag Show only those calls whose Tag value matches any of those colours
checked. The All button is a shortcut to show calls with any tag
colour.

Set Default Values Restore all the dialog default values for all parameters.

Call Manager Setup System

See also Setup Channels and Setup Timers

VOX Run-On Defines the length of time after activity ceases before the call is declared
ended. A shorter Run-on decreases the chance of consecutive calls being
concatenated; a longer Run-on decreases the chance of a call being split into
two if you stop talking. The best compromise must be found by experience.

Min Call Length This will delete a call if it's shorter than the specified duration. This is very
useful for lines with glitches when using Line Sense mode. Setting Min Call
Length to 1 effectively disables it.

Max Call Length This will split a call if it gets longer than the specified amount. No data is
lost. This is necessary because when working with disc files it is fundamental
that they are of finite length.



Oscar Communications Pty. Ltd
Oscom 400 Users Guide. Rev. 20 April 2001 Page. 18

Overview

Max Call Data This defines how much call data is accumulated before the oldest calls get
deleted. Once per minute, the program checks to see if the total size of all
calls exceeds Max Call Data OR the disc has less than 20 Mbytes available.
If so, the oldest call is deleted.

Warning Bleep This controls the generation of the warning bleep every 15 seconds during
recording. Usually it is legal to disable this unless notices are displayed
warning users that calls may be recorded and similar notification is made to
incoming callers (e.g. by means of publicity literature). If in doubt you must
consult your telecoms authority.

Call Manager Setup Channel

See also Setup System and Setup Timers

Channel Name This is a name which can be shown in the lists of calls and is embedded
within each call file.

Recording Mode This sets the condition that triggers the start and end of each call. Three types
of VOX mode are available. Quiet uses a VOX threshold of -40 dBm.
Medium uses a VOX threshold of -25 dBm. Loud uses a VOX threshold of -
15 dBm. A call starts when activity exceeds the threshold and is ends VOX
Run-on seconds after activity ceases.

Compression Calls are compressed before being written to disc to conserve space. 1:1
gives standard toll quality and generates 28.8 Mbytes per hour of call. 2:1
gives equally good quality but generates 14.4 Mbytes per hour of call. 4:1
gives slightly degraded quality but uses up only 7.2 Mbytes of your disc per
hour of call.

Password This is the password which will be used to allow access to calls made on this
channel. It is also embedded within each call file. If you login using this
password you will only have access to calls made on this channel.

VOX Voice Operated Switch

A mechanism for determining the start and end of a call by detecting voice activity on the telephone
line. The call is declared Started if 10 ms of activity that exceeds the VOX threshold is detected
and declared Ended when no activity has been detected for the VOX Run-On period.

VOX Threshold

The power level which defines the threshold of voice activity. If the mean power level on the line
exceeds the VOX Threshold for 10 ms, then activity is declared to exist, if not, silence is declared.
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2 : 1 Compression

The recorded data is compressed to half size before being recorded. The equivalent data rate is 32
kbits/sec

4 : 1 Compression

The recorded data is compressed to quarter size before being recorded. The equivalent data rate is
16 kbits/sec - (NOT OPERATIONAL).
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Call Manager Setup Record Timers

See also Setup System and Setup Channels

Record Timers The timers define 2 daily periods where Call Manager recording can be
enabled or disabled. If the Record Always button is selected, recording is
always enabled. If the Record Using Timers button is selected, recording is
Enabled between the Start 1 and the End 1 period, and also between the Start
2 and the End 2 period. Recording is Disabled at all other times. The times
entered into the timer boxes must be in the format HH:MM and must be in
sequential order.

Passwords

Oscom400 is protected from unauthorised access by passwords. When Oscom400 is started you are
prompted for a password. The password you enter will define the level of access that you are
allowed.
There are 2 levels of access.

Channel Passwords Entry of a Channel Password allows you to view and replay all calls
recorded by the Local Call Manager on the channel whose password
you entered. You can have access to more than one channel by setting
the passwords for those channels to the same value. If you enter a
Channel Password, the File/View Network Calls menu and the
Setup/Call Manager menu are disabled. The Channel Passwords can
only be changed by first logging in with the Supervisor Password,
selecting the Setup/Call Manager menu, and then pressing the Setup
Channels button.

Supervisor Password Entry of the Supervisor Password allows you access to all channels
on all Call Managers on the network, both Local and Remote. You
can also configure all of the Call Managers. The Supervisor Password
is set using the File/Password menu. You must enter the existing
password before you can change to a new one.
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File Menu
The following is a breakdown of the functions within the File Menu.

Tag Call- Displays a dialog box for marking a call with a tag colour. This sets a tag mark to appear
next to a call in the list.  The call is not effected in any other way. A call will remain tagged and
commented even on tape, and its tag mark and comment will always appear.

Play Call- Opens a replay menu for replaying selected call.

Save call- Saves call by copying it to a subdirectory called “Saved”. You can view saved calls by
means of the View Menu.  Saved calls are not deleted by file manager. You must delete them
manually when you do not require them.

Delete Call- Deletes a saved call from the saved directory.  You can only use this command to
delete calls that have previously been copied and saved.

Convert Call- Converts a call to a .WAV file.  The calls can then be replayed on any multimedia
PC.  And transmitted by email.

Print- Use this command to print a Call List from the HDD.

Print Preview- Allows you to view the call list a it will appear when printed.
Print Setup- Allows you to set the print parameters.
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Exit- Use this command to end the session.

Tag and comment call

To Save a Call

1.  Select a call from the call list.
2.  Select File from Tool Bar.
3.  Select Save Call.
The is then Copied and Saved into the ‘Saved’ directory.  To replay see View Menu/New Saved
Call List.

To Convert a Call

1. Select File from Tool Bar.
2. Select Convert Call. These calls are stored in the subdirectory WAVE.

How to Tag a Call

1.  Select a call from the Call List.
2.  Select File from the Tool Bar.
3.  Select Tag Call
4.  Tag and Comment Call box

appears.
5.  Select a Colour from the list.
6.  Press OK.

How to Add a Comment

1.  Follow steps 1-4 from above.
2.  Click in the comment box.
3.  Type desired comment.
4.  Press Ok.

How to Play a Call

1.  Select a Call.
2.  Select File From Tool Bar.
3.  Select the Play Call Option.
4.  Click the play button.

Play Box
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Print

Print Preview

How to Print

1.  Select File from Tool Bar.
2.   Select Print.
3.   Press Ok.

The Call List should
automatically print.  If you
need to configure your printer
please refer to its user manual.

Print Preview

1.  Select File from Tool Bar.
2.  Select Print Preview.
3.  Press Close to return to

main page.
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Print Setup

View Menu

The View Menu allows you to organise the layout of the screen.

New Local Call List- Use this to open a new call list from from the system.

New Networked Call List- Use this command to open a new call list from another machine on the
Oscom 400 network.

New Saved Call List- Use this command to open the call list from the Saved subdirectory.

Print Setup

1.  Select File from Tool Bar.
2.  Select Print Setup…
3.   Go to Properties to make

changes to relevant fields.

You can also adjust Printer
Type and Connection from
opening screen.



Oscar Communications Pty. Ltd
Oscom 400 Users Guide. Rev. 20 April 2001 Page. 25

User Guide

Toolbar- Use this command to display or hide the Toolbar.

Status Bar- Use this command to display or hide the Status Bar.

Filter Calls

Once the details are entered and the OK button pressed the calls will be displayed for you to
playback or scan for relevant information.

New Network Call List

A call filter will appear enter search parameters and press OK the calls will be displayed for replay.

New Local Call List

1.  Select View From Tool Bar.
2.  Select New Local Call List.
3.  Enter the search parameters

such as:
-Date
-Time
-channel
-Tag colour
-Number dialled

4. Press OK.

New Network Call List

1.  Select View from Tool Bar.
2.  Select Network Call List.
3.  Select the folder the

information is to be retrieved
from.

4.  Highlight the required file.
5.  Press OK.
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New Saved Call List- 1. Select view from Tool Bar.
2.  Select New Saved Call List.
3.  The Call Filter box  will appear enter
      parameters and press OK.

Once again once these details are entered the requested information will appear on the screen

Setup Menu

This section allows you to adjust the machine to your specific requirements.

Local Call Manager- Configures the system.  Such as recording parameters and storage space
designated to recorded files.

Supervisor Password- Changes the Supervisors access password.
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Local Call Manager Setup

Local Call Manager Channel Settings

How to use Local Call Manager

1.  Select Setup from Tool Bar.
2.  Select Local Call Manager.
3.  Adjust Minimum call Length

(recommended no more than 5
sec).

4.  Set Maximum Call Length.  If a
Call exceeds the maximum call
length it will be broken into two
files.

5.  Set Warning Bleep.  Only
required to be enabled for analog
phone line recording.  And
external device is used for digital
lines.

6.  Set Vox Settings.  Determines
when the recording is to be
initiated

Local Call Manager Channel Settings

1.  Follow steps 1-2 from the above.
2.  Select the Channel you wish to setup.
3.  Give the channel a name.
4.  Set individual password for channel
      (supervisor password over rides all
     others).
5.  Set Compression rate by pressing

highlight box next to setting.
6.  Set activation mode.  Allows you to

determine how the recording is to be
activated.
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Supervisors Password

Window

This Function allows you to arrange the appearance of the screen.

Cascade- Use this Command to arrange multiple open windows in an overlap fashion.

Tile Horizontally- Use this command to vertical arrange multiple open windows one above the
other.

Tile Vertically- Use this command to arrange multiple open windows one beside the other.

Arrange Icons- Use this command to arrange the icons for minimised windows at the bottom of the
main window.

Supervisors Password

1.  Select Setup from Tool Bar.
2.  Select Supervisor Password.
3.  If  There is no password set press OK.
4.  Enter a New password in dialog box.

And clarify it in New Password Again.
5.  Press OK.

The new Supervisor Password is now set
and is required to change any of the system
settings.
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Cascade

Tile Horizontally

How to Cascade open
Windows

1.  Open Required Calls.
2.  Go to Window from Tool

Bar.
3.  Select Cascade.

This will automatically overlap
open Calls for ease of
consecutive playback.

How to Tile Horizontally

1.  Select required calls.
2.  Select Window from Tool Bar.
3.  Select Tile Horizontally.

This will automatically arrange
calls one above the other for ease
of consecutive playback.
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Tile Vertically

Arrange Icons
1.  Minimise all open windows.
2.  Select Window from Tool Bar.
3.  Select Arrange Icons.

This will organise the icons neatly at the bottom of the page.

Real Time Monitoring

The Oscom400 allows users the ability to monitor conversations in real time. The monitoring takes
place after the data is recorded to the hard disk, so that the path can be checked for complete
operation.

You will notice if you open the Call Manager screen that beside each channel is a button. By
clicking the left mouse button on the button associated with the channel you wish to listen to you
can hear the audio. Please note there is about a 1.5 second delay between the input and the audio
output you will listen to.

To de-activate the channel monitoring click on the Calls screen and all channels are closed.

Also please note only one channel can be monitored at one time, as we are able to check the path
for complete normal operation so that the encoding and decoding of the signal is taken into account,
so determining if there is a problem with that channel.

Tile Vertically

1.  Select required Calls.
2.  Select Window from Tool Bar.
3.  Select Tile Vertically.

This will automatically arrange calls
beside each other for ease of
consecutive playback.
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Real Time Monitoring

Button beside each channel operating will allow you to listen to the audio from the speaker or the
headphones.

Password Security across the Network

The Oscom400 allows the user with remote replay software to access the Oscom 400 recorder and
play back calls across the network. However, in order to protect the security and the integrity of the
calls each channel can be password protected as per normal Oscom400 operation. This has been
extended to the Replay only software to allow users to access only their calls on a particular
channel.
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Time Synchronisation

The Oscom 400 has included three types of protocol for the connection of various time
synchronisation protocols available from GPS clocks or other master clock systems.

Click on Setup then Time Synchronisation to open the Time Sync window and complete the setup.

The user is prompted to set up the Com. Port i.e. one, two etc. the baud rate of the transmission etc.
and at present the method is between I – format or S – format. Please check with dealer about which
format to use.

There is also a check box which when checked will allow you to watch the protocol on the screen.
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Time Synchronisation cont.

To do this check the visible display box.

You can see the terminal display screen will be displayed allowing diagnostics to be carried out at
the Oscom 400.
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